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Publication Number: ETAMS-BSTM4G
FOR OFFICIAL USE ONLY
NOTICE:  THIS MANUAL CONTAINS PROPRIETARY INFORMATION
This manual contains proprietary information for use by ETAMS

personnel ONLY or by persons authorized to perform

ETAMS tasks.

March 2009
Welcome to ETAMS!  This booklet gives you instructions for completing ETAMS Base Schedules for all persons who’s Timecard you are now keeping.  A Base Schedule is the employee’s regular Tour of Duty.  Begin completing these tasks as soon as you receive these instructions.

Contact your Facility Coordinator immediately if you have questions.

	Facility Coordinator / Backup
	Telephone
	E-Mail Address

	
	
	

	
	
	



Perform these steps to complete ETAMS Base Schedules.  Steps 2 and 3 may already be done.  You must successfully finish one step before you can move to the next step.  For help, refer to this booklet, check out on-line ‘Help’ in ETAMS, or view the available FEDdesk Lessons. 

	Step
	Instructions
	Side Notes

	1
	Gather this information:

· Your FEDdesk UserID & Password

· Your completed ‘ETAMS Area/Team Organizational Worksheet’ with Area/Team numbers assigned.

· Work schedules for all your employees.


	

	2
	Add a FEDdesk Bookmark:

· Go to:  http://feddesk.gsa.gov 

· Add a Bookmark for the ‘FEDdesk System Home Page’


	

	3
	Set up your Workstation to access ETAMS:

· Go to:  http://feddesk.gsa.gov 

· Click on System Logon and log on to FEDdesk.

· If the logon screen does NOT display, go to the FEDdesk System home page.  Click on the Help tab and then click on CITRIX Information and Download Issues.

	

	4
	Log on to FEDdesk and ETAMS

UserID will be given to you (No dashes or spaces)

Password=Pass1word (lower case with a capital ‘P’)


	· Your password may be different.  Contact your Facility Coordinator.
.

	5
	Complete a Base Schedule for every employee.

· See ‘How to Add a Base Schedule’ in this booklet.

· See ‘ETAMS Base Schedule Reminders’ in this booklet

· From ETAMS Main Menu, go to Base Schedules

· Enter Base Schedules


	· Contact your local POC (Facility Coordinator) for help if needed.
· Questions? - Check out the help file which is accessed from every FEDdesk page.



	6
	LABOR: When appropriate, the Labor Feature is enabled for some employees or the entire Facility.  

· See ‘ETAMS Base Schedule Reminders’ in this booklet

· Go to on-line help and print ‘How to Add a Labor Default Schedule’ and ‘How to Add Favorites’.  Some Labor data may be pre-filled.  Verify each entry.


	

	7
	LABOR: If Labor data is to be entered for Contractors, complete a Base Schedule for each Contractor.  The Fed Payroll field is set to ‘N’.  Enter a ‘Rate of Pay’ (if required) and complete Base Schedule and Labor data as instructed.


	Note:  Contractor Labor records will be collected and processed.  Timecards are collected but not processed and must remain with the Labor record.

	8
	Contact the Certifier to have the Base Schedules signed.


	· Base Schedules cannot be signed unless they have been validated by the payroll office in Kansas City.  Contact the payroll office if the employee name is on the ‘Employees Not Validated’ report and it’s almost the end of the Pay Period.  See NOTE at bottom of page.


NOTE: Employees entered into ETAMS are either Government Employees or Contractors.  The GSA Payroll Office must validate all Government Employees.  After entering a new employee into the Base Schedule, the next time you log on to ETAMS you may get a Warning screen listing the employees that are not validated.  Employee records that are not validated cannot be certified and therefore cannot be collected.  SSN Validation takes place every night.

ACTION:  After entering the new employee record, if the SSN does not validate by the 2nd Wednesday of the Pay Period, contact the GSA Payroll Office to resolve the problem.

Base Schedule Reminders

1. Every employee must have a Base Schedule.  

2. Verify the Name fields.  If not correct, a personnel action is needed to make the change.

3. Status:  Active

4. Block:  Must be filled with a Block number from the drop-down selection.

5. Area / Team:  See your worksheet.  Must be 2 digit numbers.  Area:  _______ / Team:  _______

6. Separated Indicator (Sep Ind):  No

7. Full/Part Time/Intermittent:  Tour indicator as defined in PAR.  This is a display only field IF the person is already in PAR.  For any government employee not validated in PAR and for Contractors, this field is open for selection.
8. AWS  =  N if 8 hour days and 80 hour tour (Regular schedule or Flex schedule).

AWS  =  Y if more than or less than an 8 hour day (i.e. Compressed schedule, Part-Time or Maxi-flex). 

9. Meal Start/Meal Stop:  Leave Blank


12. Enter a suitable generic work schedule for every employee.  No employee schedule should be left blank.  See samples in this manual.
13. Put an entry on all 14 days.

14. All RDOs (Regular Days Off) or non-working days MUST have a 00 code (displayed as XX).

15. Enter  an 01 (Regular Scheduled Hours) code and the Hrs (hours and tenths of hours) for each work-day of the Pay Period.

16. Reminder:  This is not a Timecard.  Do not put any leave or overtime codes here.

17. Night Shift Differential or Sunday Premium should be entered, if appropriate.

18. All Base Schedules must be completed no later than: ___________________________________________

19. All Base Schedules must be signed no later than: ______________________________________________

20. Your first ETAMS Timecards will be ready for modification on: ___________________________________

LOGGING ON AND OFF FEDDESK/ETAMS
The FEDdesk Application is accessed via the Internet.  Use this procedure for logging on and logging off.

To Logon to FEDdesk/ETAMS:

The FEDdesk Application is accessed via the Internet.  Use this procedure to log on.

1. Double click on your browser icon (Explorer, Navigator, etc.) to access the Internet. 

2. Place your cursor at the beginning of the address field and enter the location of the FEDdesk System Home page:  http://feddesk.gsa.gov/.  Press the Enter key.  Wait for connection.
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3. From the FEDdesk System home page, single click the System Logon tab. (If you are a first-time user, a browser plugin will automatically download. 
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4. From the OCFO Web Applications ‘Log in’ window, enter your User name /UserID and press the Tab key.

5. Enter your Password and press the Enter key or click ‘Log in’.
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6. From the Applications window, click on the FEDdesk icon to open the application.  A warning message alerts you about connecting to a government computer.  Read and accept the warning by clicking OK. 
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7. From the FEDdesk Menu, single click on the appropriate item to initiate the application desired:

Items that are not available to the User are grayed out.

Note:  If the FEDdesk application has been inactive for 15 minutes, you will automatically be disconnected.

To Log Off FEDdesk/ETAMS:

To log off the FEDdesk system, perform the following steps:

1. From any ETAMS screen, select the File Menu and then Exit.  (TMR also provides an Exit icon.)  Repeat this until the FEDdesk Menu displays.  

2. From the FEDdesk Menu, click the Exit FEDdesk.

3. From the OCFO Web Applications window select another application or click Log Off and return to Windows.

Note:  The recommended ‘exit’ procedure is not to use the ‘X’ in right corner of the screen, especially from the FEDdesk Menu.  

Note:  If the FEDdesk application has been inactive for 15 minutes, you will automatically be disconnected.

CHANGING YOUR PASSWORDtc "Changing Your Password"
Use one of these two procedures to change your FEDdesk Password.  

Change Password from the GSA OCFO Applications Gateway
Use this procedure to change your Password from the GSA Applications Gateway.

1. After log on to the GSA Applications Gateway, click on the key icon to display the ‘Change Password’ screen.
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2. Enter your Old Password.  Press the Tab key.

3. Enter your new Password and then enter the new Password again for confirmation and click OK.  A confirmation message is returned when the Password change has been successfully completed.

Note:
Password Criteria is found on the FEDdesk System web site (http://feddesk.gsa.gov).  Click on the Help tab and then go to Password Criteria.

Note:
After changing your Password wait 30 minutes for updates to take effect before logging on again.

Note:
If you forget your Password, contact your Facility Coordinator.  The Facility Coordinator will set your Password back to a default to allow entry into FEDdesk.

Note:
You can also change your Password from the FEDdesk Menu by clicking on Change Password.

Change Password from FEDdesk

Use this procedure to change your FEDdesk Password from the FEDdesk Menu:

1. Click Change Password to display the ‘Change Password’ screen.

2. Enter your New Password.  

3. Press the Tab key.  Enter your new Password again and click OK.  A confirmation message is returned when the Password change has been successfully completed.

Note:
Password Criteria is found on the FEDdesk System web site (http://feddesk.gsa.gov).  Click on the Help tab and then go to Password Criteria.

Note:
After changing your Password wait 30 minutes for updates to take effect before logging on again.

Note:
If you forget your Password, contact your Facility Coordinator.  The Facility Coordinator will set your Password back to a default to allow entry into FEDdesk.

Note:
You can also change your Password from the OCFO Applications Gateway by clicking on the key icon. 

TIME CALCULATIONS
tc "Time Calculations"
Throughout ETAMS (timecards and labor records), time is expressed as hours and tenths of an hour.  
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The following Business Rules are used for all fields where time is entered:

· Time is expressed in the format: hh.t where h = 0 – 24 and t = 0 - 9.

· Minutes are expressed as tenths of an hour (1 tenth hour = 6 minutes).

· Minutes are truncated to one decimal place (no rounding).

· Entries may need to be adjusted due to rounding. (eg. 15 min of leave = .2, but one hour of leave in 4, 15-minute increments = .2, .2, .3, .3 = 1 hour).

Use the following chart to record minutes as tenths of an hour.  

	PRIVATE 
MINUTES
	TENTHS OF AN HOUR

	0   -   5
	0

	6   -  11
	1

	12  -  17
	2

	18  -  23
	3

	24  -  29
	4

	30  -  35
	5

	36  -  41
	6

	42  -  47
	7

	48  -  53
	8

	54  -  59
	9


Examples:
Timecard / Labor Entry
Actual Hours/Minutes



.7  or  0.7

 42 - 47 minutes




3  or  3.0

 3 hours




.2  or  0.2

 12 – 17 minutes




5.5


 5 hours and 30 - 35 minutes




7.2


 7 hours and 12 - 17 minutes




9.7


 9 hours and 42 - 47 minutes

SHOW START/STOP TIMES

tc "Show Start/Stop Times”
Note: START/STOP TIMES should be used only when directed by your Agency/Organization.

By default, the ETAMS Base Schedule (and Timecard, Amendment, History and Payroll Correction) displays only an Hrs (Hours) column for recording time.  Time is recorded in hours and tenths of an hour both for Regular Scheduled Hours and Exception time.  

Base Schedule hours can also be entered in 24 hour format using a Start time and a Stop time for Regular Scheduled Hours and Exception time.  
From the ETAMS Base Schedule, click in the Show Start/Stop box to display the Start and Stop columns.  Uncheck the Show Start/Stop box to hide the columns.
The display changes to show a Start column and a Stop column between each Code and Hrs column.
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After adding an entry in a Code column enter a Start and a Stop time.  Tab out of the Stop field to display the entered time in the Hrs column.

To disregard all Start/Stop times, uncheck the Show Start/Stop box and revert back to the default screen.

Rules to remember when using Start/Stop times:

*
Time must be entered in 24 hour format (hhmm) where hh = 00 – 24 and mm = 00 – 59.

*
Only actual hours worked is entered as Regular Scheduled Hours.  Do not include lunch break.

*
For every Start time, there must be a Stop time.

*
Start/Stop times and Hrs (hh.t) can both be used on the same record.

*
Meal time hours cannot be included as part of Regular Scheduled Hours or exception hours.

*
After entering a valid Start and Stop time, tab out of the field.  The Hrs column displays the equivalent time in Hours and tenths of an hour.

*
After entering and saving Start/Stop times, the default screen for the record shows Start/Stop times the next time the record displays.  

*
If Start/Stop times have been entered, unchecking the Show Start/Stop box will display a message that asks if you want to hide the Start/Stop columns and revert back to the normal view.  If you click OK to this message, all entered Start/Stop times are lost and cannot be retrieved.  Click the Cancel key to keep the format of the screen as it currently displays.

Use the following chart to record the correct 24-hour format for Start/Stop Times.  Standard Times are listed along with the corresponding 24-Hour time.

	PRIVATE 
STANDARD TIME
	24 HOUR TIME

	12:01   AM
	0001   HOURS

	1:00   AM
	0100   HOURS

	2:00   AM
	0200   HOURS

	3:00   AM
	0300   HOURS

	4:00   AM
	0400   HOURS

	5:00   AM
	0500   HOURS

	6:00   AM
	0600   HOURS

	7:00   AM
	0700   HOURS

	8:00   AM
	0800   HOURS

	9:00   AM
	0900   HOURS

	10:00   AM
	1000   HOURS

	11:00   AM
	1100   HOURS

	12:00  NOON
	1200   HOURS

	1:00   PM
	1300   HOURS

	2:00   PM
	1400   HOURS

	3:00   PM
	1500   HOURS

	4:00   PM
	1600   HOURS

	5:00   PM
	1700   HOURS

	6:00   PM
	1800   HOURS

	7:00   PM
	1900   HOURS

	8:00   PM
	2000   HOURS

	9:00   PM
	2100   HOURS

	10:00   PM
	2200   HOURS

	11:00   PM
	2300   HOURS

	12:00   PM
	Either 0000 HOURS (Start Time)

Or     2400 HOURS (Stop Time)


Examples
Standard Time 
24 Hour Time


        5:15 AM

  0515  HOURS



        2:30 PM

  1430  HOURS



      10:45 PM

  2245  HOURS


BASE SCHEDULE EXCEPTION CODES
To display valid Exception Codes for the Base Schedule, place your mouse pointer in any Code or Hrs column and click the right mouse button:  

00
Regular Day Off (X)

01
Regular Scheduled Hours

12
Sunday Premium

20
Second Shift Night Diff

22
EDP Act. Expose / OT 4%

23
EDP Act. Expose / OT 6%

24
EDP Act. Expose / OT 25%

25
EDP Act. Expose / OT 50%

26
EDP Act. Expose / OT 8%

30
Third Shift Night Diff

34
Furlough Regular

35
Furlough Lack of Funds

50
Sick Leave

51
Regular Military

52
Law Enforcement Military

55
Furlough (Over 30 Days)

56
Lack of Funds (Over 30 Days)

59
Suspension

60
LWOP

61
AWOL

62
Actual Exposure - 4%

63
Actual Exposure - 6%

64
Actual Exposure - 25%

65
Actual Exposure - 50%

66
Hours In Pay Status - 4%

67
Hours In Pay Status - 8%

68
Hours In Pay Status - 25%

87
LWOP Workman’ Comp Used

92
Telework – Long-Term 

 ETAMS SCREENS
FEDdesk Menu
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Unsigned Base Report Nag Screen
Each Base Schedule record that is not certified will display on this report until it is certified.
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Employees Not Validated Report Nag Screen
These employee records do not exist in the GSA Payroll Office.  Contact the GSA Payroll office immediately.  SSN Validation is run every night.  Contractors are NOT included on this report.
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NOTE: Other nag screens may display when a User logs on to ETAMS.  Because the other nag screens are not related to the Base Schedule record, they are not shown here.

How to Add a Base Schedule 

The information contained in an employee’s Base Schedule record is the default information used to automatically create the Timecard each Pay Period.  Perform the following steps to add a Base Schedule for a new employee.  For more information about the ETAMS and the Base Schedule, go to the ETAMS help file.

1. From the ETAMS Main Menu, click on Base Schedules.

2. Display the desired Base Schedule record:

· If the employee name is displayed on the list,

a) Double click on the employee name.

b) A message displays to tell you the SSN is not in the Base and asks you if you want to add the SSN.  Click Yes.  Continue with Step 3.

(OR)

· If the employee name is not displayed on the list,

a) Click in the SSN field, enter the SSN and click OK.

b) A message displays to tell you the SSN is not in the Base and asks if you want to add the SSN.

c) Click Yes and continue with Step 3.  (If the message says that the SSN is not in one of your valid Area/Teams, contact the Facility Coordinator.  The employee is in the database, but you cannot access the record.  The FC will be able to move the employee record or give you access to the Area/Team as needed.)

3. The SSN Validation Screen displays.  Answer the prompts to establish either a Government employee or a Contractor.

4. Click in the Name fields and enter the Last, First and Middle initial of the employee name.  Move from field to field using the Tab key.  Use either initial caps or all caps.  Complete the remaining fields on the right of the screen (most have a drop-down selection available).  These fields are:  Status, Block, Area/Team, Separated Indicator, Full/PT (display only when the employee is validated in PAR), AWS (Alternate Work Schedule), FED Payroll (may not display on some systems), Rate of Pay (may not display on some systems), Labor Emp, Craft Code, Multiplier, Add On, Ext Leave, Restricted.  In the “Code” field on the far left of the screen, enter the Regular Tour of Duty for the employee.  Valid entries are 00 (X) – Regular Day Off or 01 – Regular Scheduled Hours.  The Regular Scheduled Hours code (01) must be followed by the amount of time in the work day.  An 8-hour day would have 8.0 Hrs.  A 9-hour day would have 9.0 Hrs.  A 10-hour day would have 10.0 Hrs.  The Hrs column is always entered as Hours and tenths of hours.  There must be an entry on every day of the 14 day Tour – either a 00 code or  01. 
An employee who works 8 hours a day, every day of the 80-hour tour will have 4 days off (00 codes on each of the 4 days) and 10 Regular Scheduled Hours days (code 01)  with 8-hours (8.0) every working day.

Note:  If the schedule is defined as Intermittent, the Tour of Duty column will show all days as RDO (Regular Day Off) and this schedule cannot be changed on the Base.
Note:  If the employee is validated, the Tour of Duty cannot be more hours than the assigned tour as defined in PAR.  The Full/Part/Intermittent field is updated on the Base Schedule every night with the tour as defined in PAR.  If there is a mismatch on the Timecard or Amendment with the PAR setting, a message displays whenever the record is accessed.  

5. No other entries are needed on the Base Schedule unless the employee is entitled to special pay etc. on a regular basis requiring those Work Codes be entered - i.e. Sunday Premium, Night Differential, Hazard.  If so, enter the appropriate Exception Code number in the “Code” field, followed by the amount of time the employee is entitled to the extra pay.  The code and time must be put on each day the employee is entitled to the extra pay.  Anytime an Exception Code is used on the Timecard, the code and employee time must be entered on each day that the code is to be used.

Note: All employee Base Schedules must show 80 hours for a full-time employee or the appropriate number of hours for a part-time employee.  Validation checks are made to this record so that the Base Schedule hours must match the Regular Tour of Duty hours for the employee as shown in PARS.

Note: If this is a Labor employee, perform the steps described in the help file: How to Establish an ETAMS Employee as a Labor Employee.  When all the information on the Base Schedule is correct, contact the Certifier to “Sign” the Base Schedule.  (After the Base Schedule record has been “Signed”, if any schedule information is changed, the Base Schedule signature is automatically removed.  After the change is made to the record, the Base Schedule must then be “Signed” again by the Certifier.)

Base Schedule for Contractors

1. Contractor schedules are not validated in ETAMS.  Because of this, the ‘Full/Part/Intermittent’ field is open for selection and can be changed at any time.

2. The ‘Block’ field is not used and is grayed out.

3. ‘Fed Payroll’ field is set to ‘No’.

4. ‘Pay Code’ field is an optional field that is available for input.  

5. The ‘Hourly Rate’ field is an optional field that is available for input.  

6. The Labor Default Schedule for a Contractor is set up the same as a Labor Default Schedule for a government employee.
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ETAMS SCREENS

ETAMS Main Menu
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Base Schedule – Base Schedule Select

All employees in the Facility database will display here until they are claimed (i.e. assigned to an Area and Team).  After the Base Schedule is completed, only the Timekeeper(s) responsible for the employee Timecard will be able to access the record. 

Unclaimed (unassigned) Employee  
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BASE SCHEDULE – REGULAR, FLEX, MAXI-FLEX SCHEDULE & SIGNED
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BASE SCHEDULE - COMPRESSED SCHEDULE  (5/4/9)
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BASE SCHEDULE - COMPRESSED SCHEDULE  (5/4/9)
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BASE SCHEDULE - COMPRESSED SCHEDULE  (4-10 HR DAYS)
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BASE SCHEDULE - INTERMITTENT EMPLOYEE
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LABOR FACILITY – Government Employee
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LABOR FACILITY – Contractors
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Labor Default Schedule

When the Labor feature is turned on for the Facility, a Labor Default Schedule needs to be set up for each employee whose work projects are to be reported.  After the ETAMS Base Schedule is set up, a Labor Default Schedule should then be created.  The Labor Default schedule is an accounting of the employee’s work assignments and the percentage of time spent on each assignment.  Just like the Base Schedule is a default record of Regular Scheduled Hours, the Labor Default is the default record for reporting types of work performed during the Pay Period.
After a Labor Default is defined, the information is then used each Pay Period to create the Labor Summary record.  The Labor Summary record is then modified as needed for the Pay Period.

Perform the following steps to setup an employee’s Labor Default:

1. First, complete the Base Schedule and Close the record.

2. From the ETAMS Main Menu, go back into Base Schedules and bring up the employee’s record.

3. From the Menu bar, select Maintenance, Default.
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The Labor Default Screen displays. 

‘Favorite’ lists may or may not display on the left side of the screen and across the top of the screen.  To set up or change these lists, see, ‘Creating a Favorites List’.

4. Click in the Project and Task column in the middle of screen.  A drop-down list displays all Facility codes.  Scroll down the list and highlight the correct Project/Task for the employee.  One or many Projects/Tasks can be defined for each person.

Work Pct - Enter the percentage of Base time for the Pay Period that is to be allocated to this Labor Code.

Note:  If you enter the Work Percentage, then the # of Hours [next field] is calculated for you OR vice-versa, if you enter the Hours, then the Work Percentage is calculated for you.

Hours - Enter the number of regular hours to be allocated to this Labor Code.

OT – Check this box if all Overtime hours are to be allocated to this Labor Code.

If Overtime Hours is not applicable for this Labor Code, leave the OT box blank.

Note:  When complete, each Labor Default should display (at the bottom-right of the screen) the following information:



Total (Work Percent and Hours) 



Base Hours =  (the total number of Hours shown)



Remaining Hours =  0

Here is the completed Labor Default Schedule.
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It is suggested that Labor allocation be at least 10% for any Labor Code entered.

5. After visually verifying that all entered data is correct, click on the Close button, and Save this Labor Default as entered.

You have now set up the Labor Default which will be automatically copied to the Summary and/or Labor Detail Screen each Pay Period.  After the initial setup, the Labor Default can be changed at anytime from either Base Schedules or from Timecards.  As with any Base Schedule changes, Labor Default changes need to be made prior to Pay Period Initialization.

Changing a Labor Default Schedule

Perform the following steps to make changes to an existing Labor Default Schedule:  Changes are needed when a default Project/Task becomes Inactive.  Only Active Project/Tasks can be used on Labor records.  Changes will be effective for the next Pay Period that is to be initialized and not the current Pay Period.

A Labor Default Schedule can be changed either from Base Schedules or from Timecards.  From either option, bring up the Labor Defaul.
1. From Base Schedules, bring up the employee’s record.

Or

From Timecards, bring up the employee’s Labor Summary.

2. Click on the Maintenance menu, and then select Default.  The Labor Default Screen displays.
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3. Place the hand pointer next to the appropriate line within the middle "Summary" section of the screen.  If you are deleting an existing Summary line, with the line selected, simply press the Delete button at the bottom of the screen to remove the entry. 

If you are adding a new entry, press the Add button to have the hand pointer jump to a new blank line - perform the next step.
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4. Click in the Project and Task column in the middle of screen.  A drop-down list displays all Facility codes.  Scroll down the list and highlight the correct Project/Task.  One or many Projects/Tasks can be defined for each person.
5. Complete the remaining entry fields:

Work Pct - Enter the percentage of Base time that is to be allocated to this Labor Code entry.

Note:  If you enter the Work Percentage, then the # of Hours[next field] is calculated for you OR vice-versa, if you enter the Hours, then the Work Percentage is calculated for you.

Hours - Enter the number of Base hours that is to be allocated to the Labor Code.

OT – Labor Codes can have Overtime Hours applied to them.

If Overtime Hours is not applicable for this Labor Code, leave the OT box blank.

    (OR)

If the entry is to have Overtime Hours applied (which will be at the same percentage as defined for Base), click within the OT box to insert a checkmark.

Note:  When complete, each Labor Default should display (at the bottom-right of the screen) the following information:



Base Hours =  (the total number of Hours shown)



Remaining Hours =  0



Total Percent =  100%

It is suggested that Labor allocation be at least 10% for any entry.

6. After visually verifying that all entered data is correct, click on the Close button, and Save this Labor Default as entered.

Creating a Favorites List

Each labor employee typically spends his/her workweek on one or several Projects.  Hours, or a percentage of the workweek, are then logged to each Project worked.  Your agency may have hundreds of Project codes, but one employee may allocate all of his/her time to only 1 or 2 Project codes.  This is what a Favorite list is for.  A Favorite list is a short pick list of codes used by an employee to complete his work report for the Pay Period.  The Labor screens display two Favorite windows and the window names may be different for your agency.  One or both Favorite lists may be available for employees in your agency.  Set-up of the Favorite List is the same no matter what kind of list it is.  Setting up the Favorite List is optional, but this short list is handy when completing a work report for the Pay Period.

To Create a Favorites List

1. From Base Schedules, bring up the employee’s record.

Or

From Timecards, bring up the employee’s Labor Summary.

2. Click on the Maintenance menu, and then select Default.  The Labor Default Screen displays.
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Note:  A Favorite List can be created or modified from any Labor screen that displays the Favorite List window.  In this example, the Labor Summary screen is used.  

3. Place your mouse pointer inside the Favorite window (white window on the left or across the top of the screen, and click the right mouse button.  The Favorite window displays.
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Initially, the Favorite list window for each person starts out with All codes that are defined for Facility use shown on the right side of the screen.  Each Favorite list on the left, is then customized for the person and can be modified at any time.

4. Move the mouse down the right side of the window.  Pointing to the name of a code opens a pop-up window with the name of the code.  Find and highlight the code to add to the Favorite List.

5. Click the left mouse button and drag the code in the right column to the code in the left column.  Release the mouse button.  Continue dragging codes from the right to the Favorite column on the left side of the window until the Favorite List is complete.  
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Note:  To delete a Favorite code on the left side of the window, just drag the code back over to the right side of the table.

6. Click the Close button to close the Favorite window.  Your choices now display in the Favorite window of whatever Labor screen you are on. 

7. If a second Favorite List is used for another set of work reporting codes, use this same procedure to create another Favorite List.










Labor fields





LABOR:  If your Facility has the Labor feature enabled, also read the Labor Notes in the text boxes throughout this manual.





Including the Labor Feature











Note:  This field displays only when a Labor Facility has Contractors whose Labor data is to be entered into ETAMS.


10. Fed Payroll:  Yes for All Federal employees paid through GSA Payroll.  


No for all Contractors and any employee not paid through the GSA Payroll system.  


Rate of Pay:  Enter the appropriate rate for this Contractor.  (See your Labor Administrator for correct entries.)





LABOR:  All examples shown here have Labor enabled for the employee.  





11. Labor:    Some Labor data may be pre-filled.  Verify each entry.


Labor Emp: Yes


Note:  If Labor is turned on for the Facility, you get a reminder message to create a Labor Default for the employee.  Click ‘OK’.  The Labor Default is completed at a later time.


The following fields contain optional or default Labor settings.  Add or change this data as needed.  See your Labor Administrator for more information.


Craft Code:  _______�
Ext Leave  _______�
�
Multiplier:  _______�
Restricted:  _______�
�
Add On:  _______�
�
�
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